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Preface

This book is an attempt to cross the gap between beginning linear algebra
and the computational linear algebra that one encounters more frequently in
applied settings. The underlying theory behind many topics in the field of
linear algebra is relatively simple to grasp; however, to actually apply this
knowledge to nontrivial problems becomes computationally intensive. To do
these computations by hand would be tedious at best, and many times simply
unrealistic. Furthermore, attempting to solve such problems by the old pencil-
and-paper method does not give the average reader any extra insight into the
problem. Mathematica® allows readers to overcome these obstacles, giving
them the power to perform complex computations that would take hours by
hand, and can help to visualize many of the geometric interpretations of linear
algebra topics in two and three dimensions in a very intuitive fashion. We hope
that this book will challenge the reader to become proficient in both theoretical
and computational aspects of linear algebra.

Overview of the Text

Chapter 1 of this book is a brief introduction to Mathematica and will help the
reader become more comfortable with the program. This chapter focuses on
the commands and programming most commonly used when studying linear
algebra and its applications. Mathematica commands will always be in bold,
with output (if any) displayed in a left-justified fashion below each Mathematica
command. Readers can enter these commands and obtain the same results,
assuming that they have entered the commands correctly. Note also that all of
the images in this book were produced with Mathematica. The overall intent of
this book is to use Mathematica to enhance the concepts of linear algebra, and
therefore Mathematica is integrated into this book in a very casual manner.
Where one normally explains how to perform some operation by hand in a
standard text, we often simply use Mathematica commands to perform the same
task. Thus, the reader should attempt to become familiar with the Mathematica
syntax as quickly as possible.

At the end of each section, you will find two types of problems: “Homework

ix



X Preface

problems” and “Mathematica problems”. The former consists of strictly pen-
and-pencil computation problems, inquiries into theory, and questions about
concepts discussed in the section. The idea behind these problems is to en-
sure that the reader has an understanding of the concepts introduced and can
put them to use in problems that can be worked out by hand. For exam-
ple, Mathematica can multiply matrices together much faster than any person
can and without any algebraic mistakes, so why should the reader ever per-
form these tasks by hand? The answer is simple: In order to fully grasp the
mechanics of matrix multiplication, simple problems must be worked out by
hand. This manual labor, although usually deemed tedious, is an important
tool in learning reinforcement. The “Mathematica problems” portion of the
homework typically involves problems that would take too long, or would be
too computationally complex, to solve by hand. There are many problems in
the “Mathematica problems” portion that simply ask you to verify your an-
swers to questions from the preceding “Homework problems”, implying that
you can think of Mathematica as a “solutions manual” for a large percentage
of this text. You will also notice that several sections are missing the “Home-
work problems” section. These sections correspond to special topics that are
discussed because they can be explored in detail only with Mathematica.

Website and Supplemental Material

We suggest that students and instructors alike visit the book’s companion Web-
site, which can be found at either of the following addresses:

http://carmine.se.edu/kfrinkle/PrinciplesOfLinear AlgebraWithMathematica

http://people.emich.edu/kshiskows/
PrinciplesOfLinear AlgebraWithMathematica

At these locations, you can download Mathematica notebooks, corresponding
to each section’s Mathematica commands, along with many other resources.
These files can be used with the book to enable the reader to do problems or
practice the material without retyping the entire Mathematica code. We highly
suggest that all readers unfamiliar with Mathematica (and even those who are)
read over the relevant sections of the “Introduction to Mathematica” notebook
before they get too far into the book in order to understand the Mathematica
code more fully. Specifically, we suggest looking at plotting/graphing material,
differences between sets, lists and strings, and expressions versus functions and
how Mathematica uses each. “Homework problems” solutions and “Mathemat-
ica problems” notebooks are also available for download.
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Suggested Course Outlines

It would be nice if we could always cover all of the topics that we wanted to
in a given course. This rarely happens, but there are obviously core topics
that should be covered. Furthermore, some of the advanced topics require
knowledge beyond what students in a basic linear algebra course may have.
The appropriate prerequisites for this course would be trigonometry and a
precalculus course in algebra. Also, a computer programming course would
be helpful because we are using Mathematica. A year-long course in calculus
would also be beneficial in regard to several topics. Here is a list of sections
that require advanced knowledge:

e Section 7.2: Differentiation

e Section 7.3: Multivariable calculus

e Section 10.1: Green’s theorem

e Section 10.3: Divergence theorem and double integrals
e Section 11.3: Gradients and Lagrange multipliers

e Section 12.4: Linear differential equations

We suggest that as much of the book be covered as possible, but here is the
minimum suggested course outline:

Chapter 1 Sections 1.1-1.7 2 lectures
Chapter 2 Sections 2.1-2.3 4 lectures
Chapter 3 Sections 3.1-3.2 3 lectures
Chapter 5 Sections 5.1-5.6 8 lectures
Chapter 6 Sections 6.1-6.4 5 lectures
Chapter 8 Sections 8.1-8.5 7 lectures
Chapter 9 Sections 9.1-9.4 5 lectures
Chapter 11 Sections 11.1-11.3 3 lectures
Chapter 12 Sections 12.1-12.3, 12.5 3 lectures

Total 40 lectures

On inspection of this outline, you will notice that Chapters 4, 7, and 10 have
been completely omitted. Chapter 4 has interesting applications of matrix
multiplication to geometry, business, finance, and curve fitting, and we highly
suggest covering Sections 4.1 and 4.4. Curve fitting is covered in Section 4.2, but
is covered in greater depth in Chapter 11, where pseudoinverses and the method
of least-squared deviation are introduced. Chapter 7 contains applications of
the information learned about vectors in Chapter 6. If you wish to cover any of
the topics in Chapter 10, we highly suggest that you cover Section 7.1. Chapter
10 is a fun chapter on linear maps and how they affect geometric objects. Affine
maps are included in this chapter and should be given serious consideration as
a topic to cover.
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Final Remarks

We hope that both students and instructors will find this book to be a unique
read. Our goal was to tell a story, rather than follow the standard textbook
formula of definition, theorem, example, and then repeat for 500 pages. We
also hope that you really enjoy using Mathematica, both to explore the geo-
metric and computational aspects of linear algebra, and to verify your pencil-
and-paper work. We very much would like to hear your comments. Some of
the questions we would always like answered, from both the student and the
instructor, follow:

1. Were there topics that were difficult to grasp from the explanation and
examples given? If so, what would you suggest that we add or change to help
make comprehension easier?

2. How did you enjoy the mixture of homework and Mathematica problems?
Did you gain anything from verifying your answers to the homework problems
with Mathematica?

3. What were some of your favorite or least favorite sections, and why?

4. Do you feel there were important topics, integral to a first semester
course in linear algebra, that were missing from this text?

5. Did embedding Mathematica commands and output within the actual
explanation of topics help to illustrate the topics?

6. Overall, what worked the best for you in this text, and what really did
not work?

It would be wonderful if this text, in its first edition, were free of errors:
both grammatical and mathematical. However, no matter how many times we
read and proofread this text, it is a certainty that something will be missed.
We hope you contact us with any and all mistakes that you have found, along
with any comments and suggestions that you may have.
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Conventions and Notations

With all textbooks, one should attempt to be consistent with notation, not
only within the text, but also within the field of mathematics on which it is
based. For the most part, we have done this.

Table of Symbols and Notation
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dim(S)

%, T €L

=

Az 3, Bjk
det(A), adj(A)
p(A)
T:R—>S
Ker(T), Im(T)
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Bold capital letters designate sets of objects,
usually vectors, or a field
Real and complex numbers, respectively
n-tuples of real and complex numbers, respectively
m X n matrices with real and complex entries
Math script capital letters denote vector spaces
Dimension of a vector space S
Lowercase letters are designated as scalars
Lowercase letters with arrows over them
are vectors, or column matrices
Vectors expressed in component form
Dot product of two vectors
Cross product of two vectors
Projection of & onto v
Component of W onto
Single capital letters represent matrices
Matrix multiplication has no symbol, two
matrices in sequence implies multiplication
Transpose, inverse of a matrix
Augmented matrix, with A on the left, B on the right
Entries of a matrix are indexed by row,column
Determinant, adjoint of a matrix
Pseudoinverse of a matrix
Linear map from vector space R to vector space S
The kernel, image of a linear map T

Integral of f(u) with respect to u on [a, b]

The product z122 - - -z,

The sum z; + 22+ - + T,

Gradient of vector-valued function D

Derivative, partial derivative, of F' with respect to x
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Chapter 1

An Introduction to
Mathematica

1.1 The Very Basics

Mathematica is an extremely powerful mathematical software package (or com-
puter algebra system) that incorporates text editing, mathematical computa-
tion, and programming as well as 2D and 3D graphics capabilities. You can
literally write a complete mathematics textbook using only Mathematica where
your book includes all of the text and graphics in one smoothly flowing docu-
ment. If you have never or only slightly used Mathematica before, then it will
take some effort to learn how it works—believe me that it is well worth the
time expended for the ability to do mathematically almost anything you can
dream of that a computer might be able to do for you. In this introduction
to Mathematica, you will see only a fraction of its capabilities, but hopefully
enough to get you well on your way in doing 2D and 3D graphics, solving of
equations, defining and using functions, lists and matrices, along with some
basic mathematical programming.

This chapter discusses the fundamentals of using Mathematica for the novice
user. If you are already familiar with Mathematica, you may wish to skip this
chapter, although we warn you that to do so would be at your own risk. The
new user of Mathematica will find it quite difficult in the beginning, but with
practice and patience, you will master all of the basics and in time come to
enjoy using Mathematica.

Mathematica files are called notebooks, and in a notebook you can place text
along with input commands and their associated outputs which can be literally
anything such as graphics, tables or lists, and functions. You can group the
material in a notebook into different types of cells that are indicated on the
right side of the notebook by brackets. At the top of the notebook you will see

Principles of Linear Algebra with Mathematica®, First Edition. 1
Kenneth Shiskowski and Karl Frinkle.
© John Wiley & Sons, Inc. Published 2011 by John Wiley & Sons, Inc.



2 Chapter 1. An Introduction to Mathematica

the tab Palettes and under it is the Writing Assistant, which will allow you to
create new cells and/or modify cells. You can use Writing Assistant to change
the font, color, and size of the text in your cells and you can also do this using
the Format tab at the top of the notebook. The word processing capabilities
of Mathematica are very similar to those of Microsoft Word with [Ctrl+{C] as
copy and [CtrlH{V] as paste, [CtrlH{X] as delete and copy, which can be pasted
elsewhere.

The commands [Alt[+{9] and [Alt}+{7] will create Input and Text cells, re-
spectively, after a horizontal line break between cells. Almost all Mathematica
cells are Input or Text cells, or Output cells that are created when you activate
an Input cell. Input and Output cells are normally in pairs with Output second
directly following its Input. You can also create a new cell after a line break
by typing in some text where you can control the type of cell you are writing
in by using the menu which is open at the upper left of the screen next to the
Save (or disk) icon.

Each section or chapter of a notebook file in Mathematica should be created
as a section where the first cell of the section is a Subtitle cell that can be created
by placing a horizontal bar between or just after a cell and then choosing
Subtitle from the pulldown menu at the very top left of the lower ruler at the
top of your screen. In order to create a subsection of this section (or chapter),
do the same as just described but choose the Subsection from this menu. If you
have not already used the Window tab to insert the Toolbar in your notebook,
then please do so now. With the Toolbar in place, you can now change the
type of cell you are in by using the pulldown menu at its far left. The Ruler
can also be inserted into your notebook if you want it from the Window tab.
Note that for those of us who like our text in a larger style, Window also has
a Magnification feature that is quite handy.

If you wish to delete a cell (use [Ctrl4+[{X]) or modify its entire contents in
some way, then click on the cell tag or bracket on the right and then carry
out the desired operation using Writing Assistant or the tabs at the top of the
screen or simply [CtrlH{X] for a complete deletion. In text, in order to create
a new paragraph in a cell, use [Enter]. To do the same in an Input cell where
commands are placed, use as well. If you wish to split a cell, then use
[Shift+{Enter] with the cursor at the location of the split. In using Writing
Assistant or any pulldown tab, if you click on the triangles on the left you will
open or close one of the sections inside this tab. Note that text paragraphs
are not necessarily indented automatically, so you must indent them yourself
manually if you want this to happen.

If you wish to close a group of cells and see only the first cell of the group
(which should be the title cell of the group), then double-click on the far-right
bracket for the group. You will then see a cell bracket with an arrow to the
right of the cell bracket of the title or first cell of the group. If you double-click
on this arrow, then you can open all the cells of this group. The copy
and paste [Ctrl4{V] features of Mathematica are the same as those of Microsoft
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Word and other software. If you wish to change the size, font, or other feature
of a collection of cells, select one of them by clicking on its bracket and then
hold the key down while you select the rest of the cells—now go to the
Format tab or other location and carry out your change.

It is strongly recommended that you save (use [Ctrl+{S]) your work con-
stantly since, like all software, Mathematica can glitch, which could cause you
to loose some or all of your material. You should have backup copies of all of
your work on a separate computer or flash drive since from our own personal
experience, we know that unfortunate problems can occur.

If you are using Mathematica to do homework problems, it is strongly sug-
gested that you place each problem in a single group of cells with the first cell
as the title of the problem. This will make it much easier to organize your work
both for yourself and the instructor who may read your material. After you
have finished working in a particular Mathematica notebook, it is also recom-
mended that you delete all of your output from the file unless it will take too
long to recompute it. Most, if not all, of the size of a Mathematica file will be
due to graphics, especially 3D graphics, and such files can become very large
and consequently take Mathematica quite a while to open or save, and at such
times an error can occur. Under the tab Cell, you have the command Delete
All Output, which removes all output from the entire file—you might use this
periodically while working in a notebook in order to shorten the file. When
you reopen a notebook where all output has been deleted, you can reconstruct
it all by going to the tab Ewaluation and using the command Ewvaluate Cells;
the Input cells will then be evaluated from the first one of the notebook to the
last one.

If a Mathematica calculation is taking too long and/or you notice that there
is an error in the input, then, in order to terminate the calculation, you should
go to the Fvaluation tab at the top of the screen and select Abort Evaluation.
This should immediately halt the calculation in its tracks unless Mathematica
is stuck in some enormous loop and cannot find its way out—then your only
alternative might be to use [Ctrl|+|{AltH+{Delete| and /or turn your computer off,
that is, gently pull the plug on the machine, while apologizing to it.

Beware of using capital letters to define a quantity in Mathematica as it
might already be a built-in command name that you cannot override with
something else. You should also avoid using the capital letters C, D and N
for any kind of variable or name in Mathematica as they are also command
names. The commands Clear and ClearAll will undefine a quantity that you
have named. If you use the command Exit[], it should clear everything from
memory that you have defined and Mathematica has produced as output by
quitting the Mathematica kernel, which is the core of Mathematica.

In order to define or name a quantity in Mathematica, you must first decide
on an appropriate name that cannot be a previously used name or Mathematica
command name, nor should it be a common variable name like z, y, and z,
which you might use in equations or functions/expressions as a variable symbol.
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You can never use the same symbol or name in Mathematica for more than one
thing. Once you decide on a name such as TrialName, then in an Input cell
say TrialName = (or :=) where, after the equal sign, you must give the
expression that is the definition of TrialName. In Mathematica, an equal sign
= is used for definitions, while a double equal sign == is used in equations.
You can use != for not equals. The := is often used for defining functions
since it suppresses output and evaluation of the named quantity.

If you are using a Mathematica command, but have forgotten how to use it,
then place the cursor in the middle of the command name and hit the key
to have Mathematica bring up the Help file for this command name. You can
also go directly to Help and type in the command name yourself, especially if
you have forgotten its correct spelling. Don’t forget that every command name
in Mathematica has its first letter capitalized.

If you place a semicolon (;) at the end of a named input, then Mathematica
will not give any associated output even though it internally carried out your
command and stored it to the name given it. This feature can be useful when
the output would be very long and you do not need to see it all displayed, only
have it computed and/or stored.

Mathematica can use standard mathematical notation for powers k? and
fractions § where [Ctrl[+[6] after the base k is typed will give a power location
and [Ctrl+{/] after a numerator is typed will create a fraction and placement
for the denominator—both keys must be used simultaneously. If you use these
keys after a space, then Mathematica creates blank shells 0" and % for the
appropriate quantities to be inserted.

Finally, if you are a novice or beginner at using Mathematica, then besides
this introductory material there are many videos on YouTube that explain
most of the basic features of Mathematica. It is strongly suggested that you
seek these out and hopefully will find a few useful ones for doing what you are
interested in. Mathematica itself has tutorials that you should consider using
if you find them useful.

1.2 Basic Arithmetic

In this section, we will start to use Mathematica to do some basic arithmetic
and algebra computations. In the arithmetic, which is done first, we will add
and multiply, factor positive integers into products of powers of primes, find
the greatest common divisor (GCD) and the least common multiple (LCM) of
two positive integers, and more. In the algebra, we will factor polynomials,
divide one polynomial into another to get their quotient and remainder, solve
for the roots of a polynomial and also solve equations for their unknowns, and
perform other algebraic operations.

In order to create an Input cell where you can do your calculations, go to
the tab Palettes and bring up Classroom Assistant. Now click on the tab Create



